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invaluable assistance in the testing and development of PixFolio.

The Author may be reached via CompuServe or by writing to:

Allen C. Kempe
298 W. Audubon Dr.
Shepherdsville, KY 40165
(502) 955-7527



The Index contains a list of all Help topics available for the Help Example. For information on how to use 
Help, press F1 or choose Using Help from the Help menu.



Catalog Menu

The Catalog menu includes commands that enable you to maintain and view the contents of catalogs of 
images.

For more information, select the Catalog menu command name.

Select Catalog Add, delete, rename or select a catalog.
Catalog Catalog an image.; add, delete or update catalog entry.
Browse Browse through a catalog and search for specified criteria.
Build Build a catalog via mass update.
Rebuild Index Rebuild a catalog index & recover lost disk space due to deleted records.



Edit Menu

The Edit menu includes commands that enable you to manipulate images, access the Windows clipboard 
and undo a previous operation..

For more information, select the Edit menu command name.

Copy Copies an image or selected area to the clipboard
Cut Cuts an area from an image and places it in the clipboard.
Crop Crops an image .
Expand Expand the size of an image.
Resize Resize an image by a given percentage.
Palette Paste a palette saved    on the clipboard.
Paste Copies an image from the clipboard.
Undo Undo the last edit operation.



File Menu

The File menu includes commands that enable you to open and save files,delete or move files, and to 
print.

For more information, select the File menu command name.

Open Open a file.
Move Move or copy a file.
Print Print all or part of an image.
Select Printer Select a printer
Save Save a file and optionally convert to another format.
Delete Delete a file.
Clear Clear the screen.
Tech Info Technical Information
Exit Exit PixFolio



Option Menu

The    Option menu includes commands that enable you to set operating options.

For more information, select the Option menu command name.

Background Set background color.
Solid Background Select Solid or dithered background.
DIB Paint screen with DIBs.
Display Warnings Control Display of warning messages.
Default Options Set program defaults options.
Transparent Control display.



View Menu

The View menu includes commands that control how images are displayed.

For more information select the View menu command name.

Change Palette Change palette.
Gray Palette Gray palette.
Restore Palette Restore palette.
Slide View Display catalog as a "slide display".
Normal View Destroy "slide display".
Play Image "play" a GIF animation or GIF89a composite image.
Single Step Play Single step through a GIF animation.
Set Play Rate Vary the speed at which a GIF animation "plays".



Glossary
Bitmap
Clipboard
Color Resolution
Device Dependent Bitmap
Device Independent Bitmap
GIF



Edit Copy Command

To copy an image to the clipboard, select COPY on the Edit menu. The selection will be greyed if no 
image is being displayed.

 In order to copy part of an image, first locate the cursor at one corner of the area that you wish to copy, 
hold down the left mouse button and stretch the box to encompass the desired area. Release the mouse 
button and then select COPY from the EDIT menu.



Edit Cut Command

EDIT-CUT works similar to EDIT_COPY except that it is only effective when an area has been selected 
using the mouse. When COPY is then selected from the EDIT menu, the area will be cutout and placed in
the clipboard. The background where the image    was cut will be painted to the current background color. 
(See OPTION BACKGROUND).



Edit Paste Palette

This command can be used to replace the palette of the currently displayed image with the palette stored 
with the bitmap in the clipboard. Normally, data is pasted from the clipboard using the palette currently in 
use.



Edit Paste Command

If there is compatible data in the clipboard, it may be "pasted" by selecting the EDIT-PASTE command. 
You can    determine whether there is data in the clipboard by looking at the EDIT-PASTE menu entry. If it 
is "grayed", there is no compatible data in the clipboard.

Data to be pasted from the clipboard could have been put there by some other program, for example the 
Windows Paint program or by PixFolio itself,    earlier. 

To paste data from the clipboard, select EDIT_PASTE. The cursor will then change from an arrow to a 
crosshair. Move the crosshair cursor to the upper left corner of where you want to place the clipboard 
data.

When you are at the desired location, press the left mouse button and hold it down. While it is down, a 
box of the same dimensions as the clipboard data will be displayed. When the box is located where you 
desire, release the left mouse button and the clipboard data will be written to the screen at the location of 
the box.

Edit Expand does not alter the aspect ratio of the image, this can be done with Edit Resize.



Edit Expand

This command can be used to expand the area of an image so that additional images can be pasted 
together to form a larger image. Alternatively, an image can be cropped.

To change the size of an image, use the mouse to drag the window borders to the    desired. size. Then 
select    EDIT-EXPAND.    If the new borders are inside the old borders, the image will be cropped, 
otherwise it will be expanded. Edit Expand does not alter the aspect ratio of the image, this can be done 
with Edit Resize.

The expanded area of the image will be colored to the Background color. (see OPTIONS-
BACKGROUND).



Edit Resize

Use this option when you wish to resize an image (make larger or smaller) by a specific amount. You will 
be presented with a dialog box with two values to be inputted, one for the X (width) dimension percentage
and the other for the Y    (height) dimension. The default value for both is 100 (%).    Accompanying each 
percentage input box is an alternative pixel size edit box which can be used as an alternative to the 
percentage change. Any change entered into the size box will be automatically reflected in the pixel size 
and vice-versa.

The height can be changed    independently of the width and vice-versa allowing an image to be 
"stretched" one way or the other.    For example to increase the width by 50%, type in 150 for the X 
dimension percentage and leave the Y at 100%. For best results, the increased or decreased    image 
should be some multiple of the original, otherwise the image will be distorted. 

Flipping an Image

Two check boxes allow for reversing the image along the X axis (left - right) or along the Y axis (top - 
bottom) or along both.    If the X mirror checkbox is checked, the image will be reversed left to right and if 
the Y mirror checkbox is checked the image will be flipped top to bottom. 



Edit Crop

This command may be selected to crop the image to the dimensions of the current selection rectangle or 
the window borders.    The selection rectangle can be drawn by holding the left mouse button down at the 
upper lefthand corner of the area that you want to enclose and then dragging the mouse to stretch    the 
rectangle out. When you release the mouse button, the rectangle will stay on the screen and EDIT CROP 
can be selected to crop the image to the size of the rectangle.



Edit Undo

Sometimes it may be desirable to "undo" the previous edit operation if the result is not what was desired. 

PixFolio saves the current image before performing any operation on it so it is possible to back up by 
selecting EDIT-UNDO..

Note: The undo buffer is only one deep. You can only undo the last operation. It would be wise to save 
your file at critical steps if necessary.



File Open Command

Select this command to read and open a new image for viewing. If the file is cataloged, the CATALOG-
BROWSE command may also be used to open a file.

PixFolio will automatically    specify a list of extensions to search for. This default extension list is loaded 
from WIN.INI whenever PixFolio starts up; different file extension lists can be established for each 
catalog. If you do not want to default to certain file extensions, the entry "Extensions=" under [PixFolio] in 
the WIN.INI file and for each catalog in the Catalog Select command may be changed to suit your 
requirements. A valid file extension list is of the form "*.xxx; *.yyy;" etc. Note that each extension is 
separated by a semicolon ";". 



File Print Command

Select this command to print the currently displayed image. A portion of the image only may be printed by 
first using the mouse    to (see Copy) select a rectangular area to print.

Note: Printing takes a long time. Printing once initiated, can be cancelled by pressing "Cancel" in the 
dialog box that is displayed while printing is taking place.



File Select Printer

This command can be used to select which printer you wish to use for a subsequent print command. 
Depending upon the printer, you may also be able to set various printer options such as portrait or 
landscape mode.



File Save Command

Select this command to save an image or create a new copy of an image in a different format.

FILE_SAVE defaults to the current filename. If you wish to change the name and/or directory, you may do
so. The extension used will determine the file format although this can be overridden by pressing the 
"format"    button which will display a number of radio buttons that can be used to select the desired format
and color resolution of the output file.

File Formats:

File formats supported by PixFolio are:
GIF            CompuServe Graphics Interchange Format. PixFolio    supports both the GIF87a and GIF89a 

standard. ("The Graphics Interchange Format (C) is the Copyright property of CompuServe 
Incorporated. GIF(sm) is a Service Mark Property of CompuServe , Incorporated.")

PCX         Z-Soft Paintbrush files.
TIFF         Tagged Image format.
BMP         Windows bitmap format.
RLE Windows Run Length Encoded file format.
IFF Deluxe Paint II LBM & IFF files. The file extension "CE" is created by Digital Vision's 

Computer eyes video capture product. 
TGA         Targa file format.    (TrueVision Advanced Raster Graphics Array)

Color Resolution Formats

Images can be saved in    several resolutions:
1 BPP I bit per pixel or two colors, black & white.
4 BPP 4 bits per pixel or 16 colors.
8 BPP 8 bits per pixel or 256 colors.
24 BPP24 bits per pixel or 16 million colors. 

Not all file format and color resolution combinations    are valid either because the 
combination is not supported or because the format specification does not provide for it.    
Invalid color resolution options will be "grayed" and cannot be selected.

File Compression

Although most of the file formats supported provide for compressing the pixel data, PixFolio 
currently only supports compression for    GIF, PCX , TARGA & RLE    files. PCX and TARGA files
can be saved    in either compressed or non-compressed format. When PCX or TARGA is 



chosen, a check box will be displayed.; if checked, the file will be compressed otherwise it 
will be written uncompressed.



File Delete Command

Selecting this command will cause the currently displayed image to be deleted from its location on disk. If 
the file is present in the currently selected catalog, it will be deleted from there as well. FILE_DELETE will 
not deleted catalog entries from other than the current catalog. 



File Move/Copy Command

This command may be selected to move or copy the currently displayed file to another location.    For 
example, to organize your files or to create a backup copy. The change of location will be updated to the 
catalog. 

Move/Copy does not change the file's format. It simply copies the disk    data from one location to another.
"Move" implies that the original file will be deleted after copying. To copy, that is to say, end up with two 
copies of the file, select the Copy option checkbox.

If the file is located in the currently selected catalog, the catalog entry will be updated to reflect the new 
location of the file. If doing a move or copy and the file is renamed, the catalog entry will also be renamed.



 File Clear Command

This command will close a file without exiting PixFolio. The screen will be erased of the current image.



File Tech Info Command

If an image is currently displayed, this option will display a dialog box that contains a scrollable window 
that lists various technical attributes of the file. Also, if any errors were encountered while reading the file, 
they will be displayed here.

The technical attributes of a file format may be significant when attempting to which determine specific 
format options are used. For example, if the file is compressed, it will be displayed here. PixFolio does not
support all permutations of format options for all files and of course is unaware of new options that might 
be added to a format specification in the future.

The format and content of the display is dependent upon the file format; some formats may display more 
information than others.



File Exit Command

Use this command to exit PixFolio.



File Main Command

Use this command to close a view    window; the image will subsequently be displayed in the main 
window.



Catalog Select Catalog Command

This command will cause a dialog box to be displayed that will enable you to select, add, delete or 
change the name of a catalog. 

A catalog has a "Title" which can be anything that you wish it to be. It could be descriptive of the type of 
images, e.g. "GIF 640x480" or relating to a topic, e.g. "Nature". Each catalog has a DOS file name and 
path associated with it.    This path will also be the default path for files in that catalog.    An ther    property 
associated with a catalog is the default extensions fo files that will be displayed in the File Open and 
Catalog Build dialogs.

The first time that    PixFolio    starts up, it will create a catalog titled "Default" and named "PIXFOLIO.CAT 
(its corresponding index is PIXFOLIO.CIX). The default catalog and its index will be located in the same 
directory as PIXFOLIO.EXE.

You may establish as many catalogs as you wish. The names of defined catalogs and their pathnames    
are saved in WIN.INI. 

Select New Catalog
PixFolio can only work with one catalog at a time. This requires you to "select" which of the catalogs that 
you have defined. Until you change the selection, this is the catalog that will be updated by any 
subsequent catalog commands.    

To select a catalog, highlight the desired catalog in the Catalog combo box. Make sure that the "Select 
New Catalog" radio button is checked and press "OK".

Change Catalog Title / Ext 
Highlight the catalog whose title you wish to change. You may also change the list of file extensions that 
will be displayed in the File Open and Catalog Build functions while this catalog is selected. Then check 
the "Change Catalog Title". Next, enter the new name in the Catalog Title edit box. Then press "OK".

When a new catalog is selected, the current directory will be set to that of the Catalog's file name.

Note: changes to the default extensions for a catalog will not be effective until that catalog is selected 
again.

Delete Catalog
Highlight the title of the catalog you wish to delete.    Then check the "Delete Catalog" radio button. Then 
press "OK".

Create New Catalog
Press the "Create New Catalog" radio Button, fill in the title of the catalog in the New Title edit box. Next, 
enter a filename for the catalog. An extension is not necessary! Use the file list box to select a path to 
where the catalog should be placed , enter a list of file extensions to be in effect for this catalog and then 
press "OK".

Note: It is suggested that the catalog be placed in the directory where the majority of the files that will be 
cataloged in this catalog because selecting the catalog will set the current directory to that of the catalog 
file name.

Default Catalog

The default catalog, that is to say, the catalog that will be selected upon startup, is definable via the 
Option Default Options command. 



Catalog Catalog Command

This command can only be executed when an image is being displayed.    This command is used to add 
or update an entry in a selected catalog. The previously selected catalog will be used but can be changed
by selecting a new catalog with the Catalog combo box.

Selecting this option will bring up a dialog box with a number of fields that you can enter into. Other fields 
are updated by the program.

User Fields
Title          This is the title of the image.If a GIF89a image has a title, it will be filled in automatically. The 

maximum number of characters that can be entered is 59, including carriage returns and line 
feeds.

Keywords This field can contain a      number, up to the length of the entry box, of keywords to be used for 
searching. These keywords can be used to select    a list of files meeting requested search 
criteria. The maximum number of characters that can be entered is 87.

Description This field can be used to enter any descriptive data concerning the file up to a limit of 1200 
characters. This field can be scrolled and edited using standard editing commands. If a GIF89a 
image has text data included with it, it will be placed here.

Program Fields:
Filename The name of the file.
Icon This is a postage size view of the image. Clicking on the image will cause it to be regenerated.
Pathname The primary location (hard disk) pathname and volume label are displayed as well as the 

backup(floppy disk) location. Therefore, there can be two access paths for the file.
Info The height, width , number of color bits and file format are displayed in a box in the lower left 

corner.

There are several functions which can be performed by pressing the following buttons:
Catalog/Update Update the catalog; "Catalog" means that this is a new entry. If desired, the target catalog

can be changed beforehand.
Uncatalog    Delete the catalog entry. This button will be grayed if there is no catalog entry to delete. This 

option does not delete the file itself.
Cancel Cancels the dialog and returns you to the main menu.



Move        Moves the file to some other location.
(image) The "postage stamp" image is itself a button. When the original image is displayed, clicking on 
the "pstage Stamp" will cause it to be re-generated. this is useful if you had previously cataloged the 
original image and now have made a change to it like brightening it or cropping it.    In Browse mode, 
clicking on the image has no effect.

Note: The above buttons are redefined if the dialog is entered via the CATALOG_BUILD command.; 
"Catalog" or "Update" becomes "Next",    Uncatalog becomes "Previous" and "Move" 
becomes "View".



Catalog Browse Command

The CATALOG_BROWSE command provides a dialog box listing the files in a catalog. The target catalog
can be changed by selecting another catalog from the Catalog combo listbox.

There are a number of functions that can be applied to a file:
Move /Copy File The file can be moved or copied to another location.
Delete File  The file can be deleted from the hard disk. The file is also deleted from the catalog.
View Image The file can be opened and viewed.
OK The catalog entry for the file can be viewed and updated. Double-clicking the file name is the 

same as pressing the OK button. When the catalog entry dialog is displayed, the OK , Delete and 
Move buttons are replaced by Prev, Next and View respectively.

Cancel   Cancels the dialog returning you back to the main viewing window.
Uncatalog Deletes the file from the catalog only.

File Search

Four    different search criteria can be applied to a catalog to restrict the catalog list to a subset. The four 
categories    that can be used for the search are:

1. Whether a backup copy exists.
2. File Format, e.g. GIF87a, TIFF, PCX, etc.
3. Match on one or more keywords.
4. Match on special conditions, e.g. file size, width, height, number of colors or 

backup volume name.

The Search    function can be accessed by pressing the Options >> button:



After a search operation.

To search, place the desired search value(s) in either the Format edit box    (29 characters max.), Special  
Conditions (87 characters max) or the Keywords (87 characters max) edit box. If nothing is put    in a box, 
it will not be used in the search. The "Backup File" checkbox is a three-state control. If the box is gray, 
then it will have no affect on the search. If the box is blank, then all catalog records that do not have a 
backup location will be selected. If the box is checked, only those catalog records with a backup file 
location will be selected. The three search criteria are ANDed to select    a record. That is to say, if search 
criteria 1 (Backup) is satisfied AND search criteria 2 (File Format)    AND search criteria 3 (Special 
Conditions) AND search criteria 4 (keywords) are satisfied, the record will be selected.

Wildcard characters "*" & "?"    can be used in search arguments. For example, to select all "GIF" files, the
search argument "GIF*" will select both GIF87a & GIF89a". Either spaces or Commas may be used to 
separate    search arguments. The underscore character "_" may be used in place of a space in a search 
argument if that space is significant. For example STAR_TREK will search for the string "Star Trek" while 
STAR TREK will hit on either "Star" or "Trek".

In order to include in the search special conditions such as file size, image width, etc, PixFolio has    5 
special search arguments that can be used in the Format and Special Conditions boxes. Do not use one 
of these special codes in the Keywords box! The special codes all start with an "@" sign followed by a 
Code for the particular value to be tested for, an operator ( "<" - less than, "=" - equal . "#" - not equal, or 
">" - greater than) , followed by the value to be tested for.

The valid codes are:

"B" - backup volume name.
"C" - number of colors, 2, 16, 256.
"D" - date in format mm-dd-yyyy
"H" - height of image.
"P" - primary path name
"S" - file size in bytes.
"W" - width of image.

Some examples:
@W=320 select images whose width is 320 pixels.
@D=01-01-1991 select all dates later than January 1, 1991.
@B=GIF0020 select all images residing on backup volume "GIF020"
@C>16 select all images with more than 16 colors.
@P=C:\PIXFOLIO select all images in subdirectory "C:\PIXFOLIO"



The catalog will be searched for records meeting the desired criteria when the Search button is pushed. 
At the completion of the search, the new catalog list will be displayed in the listbox.    To change the 
search criteria, enter new search values and press Search again.

The modified catalog list will be in force until the "Show All" button is pressed, a new catalog is selected or
another search operation is performed. The VIEW SLIDE VIEW command will only display the currently 
selected catalog entries. 
 



Catalog Build Command

This command    provides the ability to select    one or more files from a specified input directory for 
automatic updating to the catalog.
 
All files in the directory can be selected by clicking on the "Select All" check box.; all files will be 
highlighted. Any files that are not desired can be deselected by clicking on the file name. Clicking on the 
"Select All" box a second time will un-highlight all files.

All highlighted files will be cataloged if they are not already. PixFolio will not bother to read images into 
memory that are already cataloged. However, file volume and pathname information will be updated for 
existing catalog records. This feature provides an easy way to update PixFolio with information on backup
copies of images stored on your hard disk. Just do a "Build" on the floppy disk in drive A or B and the 
backup location of the files will be quickly updated to the catalog. Another use for the "Build" command is 
to update the catalog to reflect the new locations of files on your hard disk after you have moved them 
outside of PixFolio.

 If the "Auto Update" option is selected. all of the files will be cataloged without any intervention; otherwise
you will be prompted for each file so that you may fill in the Title, Keywords and Description entries. The 
Auto Update option is useful for mass updates or for initial creation of a catalog.

PixFolio may halt for certain errors and warnings if the Option Display Warnings menu selection is 
checked.    You may temporarily enable or disable this feature by checking the "Stop on Error" checkbox.   
You may also change the default setting via the Option Default Options command. This will prevent 
stopping the build process except for the most serious errors. Please keep in mind that processing 24 bit 
images may cause your computer to appear to "hang" while Windows processes the bitmaps. 

The catalog that will be updated can be selected by using the Catalog Combo listbox.



Catalog Rebuild Index Command

This command should be used when it is necessary to recover lost disk space in a catalog. This may be 
necessary after doing a lot of maintenance to catalog entries, particularly editing and adding to 
descriptions. When the catalog record is re-written, the space previously allocated in the file for the record
is not used and either a previously deleted record that is large enough is used or the file must be 
expanded. 

CATALOG-REBUILD    re-writes the catalog    and eliminates any deleted records resulting in a smaller 
catalog file and index.

It is suggested that a backup of the catalog be made before CATALOG -REBUILD is executed.



Options Background Command

This command can be used to select a background color to be used    when an image is resized with the 
EDIT_EXPAND command. It presents a dialog box that can be used to establish a custom color.

The default background color when PixFolio starts is Green. The background color may change due to 
reading in    an image that specifies a background color. GIF files do specify a background color.

The background colors that can be selected will be one of the colors in the image's palette.



Options Solid Color Command

If this option is checked, the background will be written with a solid color. Otherwise, a dithered color will 
be used.



Options DIB To Screen

This option controls the way that PixFolio displays images. If this option is checked, the screen will be 
painted directly using the current Device Independent Bitmap (DIB) rather than a device dependent 
bitmap (DDB).    Displaying a DIB is slower than displaying a device dependent bitmap. However, the 
downside is that there could be a lengthy delay, especially when 24 bit color images are read in, while the
device dependent bitmap is being created.



Options Display Warnings

This option toggles on or off an option to suppress the display of certain warning messages. Once you 
have experience with PixFolio, you may wish to turn this option off. 

Any change to this option affects only your current session of PisFolio. The default value upon startup can
be set via the Option Default Options command.



Options Transparent

This option controls how certain bitmap operations such as drawing a sizing box are performed. With 
transparent off, a solid color is used. Otherwise, a contrasting color is used. 



Options Default Options

This command displays a dialog box enabling you to establish startup options that take effect when 
Pixfolio is started up. The options that can be set are:

1. Default Catalog, the initial catalog that will be selected.

2. Default    file extension list that will be used to set up the corresponding option in the Select 
Catalog function when a catalog is created. An extension file list is a series of wildcard file 
specifications. Multiple selections can be made; each selection must be separated by a 
semicolon ";". An example is: "*.GIF; *.TGA" to display GIF and Targa files.

3. The default subdirectory that will be in effect initially. Once a new catalog is selected, the current 
directory will be set to that of the catalog. If this option is not specified, the initial subdirectory will 
be that of the default catalog.

4. Whether warning messages are to be displayed. Warning mesages for the session only can be 
changed via the Options Display Warnings command.



View Change Palette

This command allows you to adjust    the brightness and/or the contrast of an image. Which option is 
selected is determined by the state of the two radio buttons labelled "Brightness" and "Contrast.".

The brightness has a range of -200 to +200 and the contrast has a range of -10 to +10.    A positive value 
for brightness will brighten the image, a negative value will darken it. Increasing the brightness will make 
all of the colors brighter by an equal amount. A positive value for contrast will increase the contrast while a
negative value will decrease the contrast.
Contrast on the other hand alters the brightness of colors unequally. If you have an image with a very 
dark background, an adjustment of the contrast, say by -2, may be in order. Once details in the dark areas
become discernable, the brightness may be increased.

Making contrast and brightness adjustments can result in a loss of image detail. You should be aware of 
this when attempting to find the right adjustment to make. You should avoid making an adjustment and 
then backing up. For example, adjusting the brightness by 100 and then backing up by 50 will result in 
loss of detail for the brighter colors, resulting in a "posterized" image. If you try an adjustment that is too 
much, restore the palette using the Restore Palette command    and then adjust the brightness or contrast 
again using a smaller value.

Although a brightness and contrast adjustment cannot be made concurrently, it is permissible to, for 
example, to make an adjustment to the contrast and then follow with an adjustment to the contrast.

This command is enabled only if your video driver supports a palette. The VGA driver shipped with 
Windows does not support palettes.

The original palette can be restored with the VIEW RESTORE PALETTE. (Unless it is a 24 bit color 
image).

Note: 24 bit color images do not have a palette so invoking this command while displaying a 24 bit color 
or gray scale image    requires that    all of the RGB    values in the image must be changed and new 
bitmaps rebuilt. This can take quite a while if your video driver does not directly support 24 bit color. It is 
suggested that 24 bit color images be saved as 8 bit (256 color) images first. PixFolio and Windows can 
process 8 bit color images much faster and if your video display only supports 8 bit color, you will not lose 
much picture resolution.

The huge memory requirements of a 24 bit color image preclude saving a copy of it so that it can be 
restored so the VIEW RESTORE PALETTE function is not available for 24 bit images.



View Gray Palette

This Command converts a color image to a gray-scale image. 

Conversion of 24 bit color images can be lengthy. See VIEW CHANGE_PALETTE.

The original palette can be restored with the VIEW RESTORE PALETTE.(unless it is a 24 bit color or gray
scale image).



View Restore Palette

This command restores the original    Palette that you had before doing a VIEW CHANGE PALETTE    or 
VIEW GRAY PALETTE command.

This command is enabled only if your video driver supports a palette. The VGA driver shipped with 
Windows does not support palettes. Because of the huge memory requirements,    this command is not 
availble for 24 bit color or gray-scale images.

This command restores the original palette from before    VIEW_CHANGE PALETTE was run.



View Slide View

This command will display a series of small bitmaps of images in the currently selected catalog, side by 
side . The number of catalog entries displayed depends upon the size of the current viewing area.; the 
maximum number of slides can be displayed by maximizing the window. Also, the sizing border of the 
window can be moved to increase or decrease the viewing area.

The content of the display can be modified by utilizing the CATALOG BROWSE , Search operation to limit
the catalog list to desired entries.

Slides displayed can be viewed by clicking the mouse on them. Holding the left mouse button down will 
display a popup menu with two options, VIEW    and INFO. View will cause the image to be displayed. Info
displays a dialog box with text information such as title, description, etc.

Keyboard control

The Page-Up and Page down keys will scroll the slide display through the catalog list.

The Up-arrow and down arrow will move the display up or down one line respectively.

Selecting VIEW-SLIDE VIEW will cause any currently displayed image in the main viewing area to be 
erased. 



View Normal View

Selecting VIEW-NORMAL VIEW causes the slide display produced by VIEW_SLIDE VIEW to be 
destroyed. The main viewing window is erased to a gray background .

The VIEW-NORMAL VIEW command will be grayed if there are no slides being displayed.



View Play Image

This    command when selected will "replay"    a GIF87a animation or a GIF89a composite image. This 
command is only enabled if such an image was read. 

GIF animations consist of a series of images that are displayed one by one in sucession . The Single Step
command can be used to step through an animation and the Set Play Rate command can be used to set 
the speed of the animation.



View Single Step Play

This menu option will toggle an option to either single step through a GIF animation sequence or play the 
sequence normally. When the menu is checked, GIF animation sequences will be played one frame at a 
time.    To proceed to the next frame, double click the mouse in the window where the image is displayed 
or press any key.



View Set Play Rate

This command can be used to vary the delay time between successive frames in a GIF87a animation 
sequence. The time is entered in 1 thousandths of a second (milliseconds). A larger delay will slow down 
an animation sequence. The default    setting is 100 milliseconds.

Note: This command only affects GIF87a animations. The delay between frames for GIF89a animations is
defined within the GIF image itself by the creator of the image.



Context Sensitive Topics

This Help system includes topics that you can call directly from the PixFolio sample application. To get 
context-sensitive help from PixFolio, press Shift+F1 and click on any element of the PixFolio application 
window. You can also highlight any PixFolio menu command using the keyboard and press F1 to get help 
on the command. 



Clipboard Operations

The ability to modify images is possible because of the Windows Clipboard. The image area can be 
expanded (see Edit Expand) Then portions of the existing image may be cut (see Edit Cut) or copied    
(see Edit Copy).    Or, data in the clipboard from similar operations in other windows programs can be 
inserted via Edit Paste.

 Currently displayed images can be resized by cropping them(see Edit_Crop).



Format Conversions

PixFolio can be used to change the format of an image form one format to another. This is useful when 
you have an image that you wish to input to another program that doesn't support that format. In this 
case, read the image into PixFolio and then save it to the desired format.

PixFolio images may be saved in the following formats:

GIF87a  CompuServe Graphics Interchange Format.
TIFF  Tagged Image Format. 
PCX  Windows paint.
TGA  Targa
BMP  Windows bitmap format.
RLE  Windows Run Length Encoded.



Stretching an Image

An image or portion of an image can be stretched by using the mouse first to select an area. This is done 
by holding the left mouse button down and stretching out a box to cover the desired area. Then place the 
cursor at the upper left corner of where you want to origin the stretched image and hold the right mouse 
button down until the stretch box is of the desired size. Releasing the right button will cause the stretched 
bitmap to be written to the screen.

If you know the amount that you want to stretch an entire image to, the Edit_Resize command may be 
used.



Exit PixFolio

Several methods may be utilized to exit PixFolio.
1.. Select    CLOSE from the system menu or double-click on the system menu icon.
2.    Select EXIT from the FILE menu    or press ALT-F4
3.  Select CLOSE from the FILE menu. However, if an image is currently being      viewed       from 

the slide layout screen, only that image will be closed.



Edit Window

When displaying an image in the Edit window, the mouse may be used to select an area for subsequently 
copying or cutting to the clipboard or to select and stretch a portion of the image.



Maximize Icon

Press this icon to make the screen the maximum size. This may be desirable before executing the VIEW-
LAYOUT SLIDES option.



Minimize Icon

This icon may be pressed to reduce the screen to an icon. The icon may be selected later to restart 
PixFolio where you left it.



Sizing Border

The size of the image displayed may be altered by dragging the mouse on the sizing border to make the 
window larger or smaller. The image's size can be permanently changed to the new size by use of the 
EDIT-EXPAND function. 

If slides are currently being displayed as a result of the VIEW-LAYOUT    SLIDES command, the number 
of visible slide windows will be increased or decreased in accordance with the new area of the window.



System Menu

This topic describes the system menu.



Title Bar

This topic describes the title bar that is used for application and document windows.





Windows Keys

Choose from the following list to review the keys used in Windows:
Cursor Movement Keys
Dialog Box Keys
Editing Keys
Help Keys
Menu Keys
System Keys
Text Selection Keys
Window Keys

PixFolio Keys Keys defined by PixFolio.



Cursor Movement Keys

Key(s) Function

DIRECTION key Moves the cursor left, right, up, or down in a field.
End or Ctrl+Right Arrow Moves to the end of a field.
Home or CTRL+Left Arrow Moves to the beginning of a field.
PAGE UP or PAGE DOWN Moves up or down in a field, one screen at a time.



Dialog Box Keys

Key(s) Function

TAB Moves from field to field (left to right and top to bottom).
SHIFT+TAB Moves from field to field in reverse order.
ALT+letter Moves to the option or group whose underlined letter matches 

the one you type.
DIRECTION key Moves from option to option within a group of options.
ENTER Executes a command button.

Or, chooses the selected item in a list box and executes the 
command.

ESC Closes a dialog box without completing the command. (Same as
Cancel)

ALT+DOWN ARROW Opens a drop-down list box.
ALT+UP or DOWN ARROW Selects item in a drop-down list box.
SPACEBAR Cancels a selection in a list box.

Selects or clears a check box.
CTRL+SLASH Selects all the items in a list box.
CTRL+BACKSLASH Cancels all selections except the current selection.
SHIFT+ DIRECTION key Extends selection in a text box.
SHIFT+ HOME Extends selection to first character in a text box.
SHIFT+ END Extends selection to last character in a text box



Editing Keys

Key(s) Function

Backspace Deletes the character to the left of the cursor.
Or, deletes selected text.

Delete Deletes the character to the right of the cursor.
Or, deletes selected text.



Help Keys

Key(s) Function

F1 Gets Help and displays the Help Index for the application. If the 
Help window is already open, pressing F1 displays the "Using 
Windows Help" topics.
In some Windows applications, pressing F1 displays a Help topic
on the selected command, dialog box option, or system 
message.

SHIFT+F1 Changes the pointer to  so you can get Help on a specific 
command, screen region, or key. You can then choose a 
command, click the screen region, or press a key or key 
combination you want to know more about.

(This feature is not available in all Windows applications.)



Menu Keys

Key(s) Function

Alt Selects the first menu on the menu bar.
Letter key Chooses the menu, or menu item, whose underlined letter 

matches the one you type.
Alt+letter key Pulls down the menu whose underlined letter matches the one 

you type.
LEFT or RIGHT ARROW Moves among menus.
UP or DOWN ARROW Moves among menu items.
Enter Chooses the selected menu item.



System Keys

The following keys can be used from any window, regardless of the application you are 
using.

Key(s) Function

Ctrl+Esc Switches to the Task List.
Alt+Esc Switches to the next application window or minimized icon, 

including full-screen programs.
Alt+TAB Switches to the next application window, restoring applications 

that are running as icons.
Alt+PrtSc Copies the entire screen to Clipboard.
Ctrl+F4 Closes the active window.
F1 Gets Help and displays the Help Index for the application. (See 

Help Keys)



Text Selection Keys

Key(s) Function

SHIFT+LEFT or RIGHT ARROW Selects text one character at a time to the left 
or right.

SHIFT+DOWN or UP Selects one line of text up or down.
SHIFT+END Selects text to the end of the line.
SHIFT+HOME Selects text to the beginning of the line.
SHIFT+PAGE DOWN Selects text down one window.

Or, cancels the selection if the next window is 
already selected.

SHIFT+PAGE UP Selects text up one window.
Or, cancels the selection if the previous 
window is already selected.

CTRL+SHIFT+LEFT or RIGHT ARROW Selects text to the next or previous word.
CTRL+SHIFT+UP or DOWN ARROW Selects text to the beginning (UP ARROW) or 

end (DOWN ARROW) of the paragraph.
CTRL+SHIFT+END Selects text to the end of the document.
CTRL+SHIFT+HOME Selects text to the beginning of the document.



Window Keys

Key(s) Function

ALT+SPACEBAR Opens the Control menu for an application window.
ALT+Hyphen Opens the Control menu for a document window.
Alt+F4 Closes a window.
Alt+Esc Switches to the next application window or minimized icon, 

including full-screen programs.
Alt+TAB Switches to the next application window, restoring applications 

that are running as icons.
Alt+ENTER Switches a non-Windows application between running in a 

window and running full screen.
DIRECTION key Moves a window when you have chosen Move from the Control 

menu.
Or, changes the size of a window when you have chosen Size 
from the Control menu.



PixFolio Keys

Key(s) Function

     ESCAPE key Can be used where ever a Cancel button is displayed.

      CONTROL + INS Copy to the clipboard. See Edit Copy.

      SHIFT + DELETE Cut a portion out of an image. See Edit Cut.

      SHIFT + INSERT Paste from the Clipboard to the current image. See Edit Paste.

      SHIFT + F12 keys Save an image. See Edit Save.

      CONTROL + F12 Open image. See File Open.

      CONTROL + SHIFT +F12 Print image. See File Print.

      ALT + F4 Exit PixFolio.

      BACKSPACE + ALT Undo last edit operation. See Edit Undo.

      CONTROL + "P" "Play" a GIF animation sequence.
 



Clipboard

The Clipboard is used by PixFolio to transfer bitmap information to and from other applications that utilize 
compatible formats. PixFolio only supports standard Windows Clipboard formats (palette info, device 
dependent bitmaps and device independent bitmaps or DIB's.

The Cut or Copy commands transfer image data from PixFolio to the Clipboard. If a region is not selected 
by using the Mouse and the left mouse button, the entire image will be copied to the Clipboard.

The Paste command can be used to transfer a image or portion of an image in the clipboard to your 
current image. Selecting Paste will change the cursor to a crosshair. Then, while you hold the left mouse 
button down, a box whose dimensions are the same as the Clipboard data can be moved around until it is
positioned properly. Releasing the left mouse button will allow the clipboard data to be displayed.

The Paste Palette command    can be used to replace the current palette with one from another image in 
the clipboard. When the Cut or Copy commands are used, a copy of the palette in use is also copied to 
the Clipboard. This palette can then be "pasted" just like the image except that    not being an entity in the 
physical sense, it is not necessary to position it.    While pasting a palette may be necessary in some 
instances, the use of this function is limited; the images must have a similar color map structure to avoid 
unwanted changes to the colors in the image.



Device Independent Bitmap (DIB)

Device Independent Bitmaps are a way of representing an image in a manner that is independent of the 
hardware upon which they are displayed. 

DIB's are used to store images which must be displayed in a number of different environments. They 
contain all elements which might be needed by different display hardware. Windows BMP files are simply 
DIB's with a header tacked on.



Device Dependent Bitmap (DDB)

Device dependent Bitmaps are a way of representing an mage that is dependent upon the hardware 
characteristics of the display device. Windows uses DDBs internally. However, a DDB created for one 
device such as VGA    can only be used for VGA. For this reason, the DIB format is used when images 
must be transferred to another environment.



Color Resolution

Windows can handle four different color resolutions defined as bits per pixel or the number of bits used to 
describe the color.. 1 bit of color resolution can result in 2 colors, (usually Black or White). 4 bits will allow 
for 16 colors. 8 bits will allow for 256 colors. These are the most common values found in most images. 
Note that in order to display 256 colors, you must have a    video board and Windows video driver capable
of displaying 256 colors; the standard VGA driver can only display    16 colors.

Many    images produced by scanners have 24 bit color resolution which is good for several million colors. 
Unless you have one of the newer graphics cards capable of displaying 24 bit color, 24 bit images will be 
displayed in 8 bit mode.    



GIF

GIF stands for Graphics Interchange Format. It is a bitmapped graphics format introduced by 
CompuServe. "The Graphics Interchange Format (C) is the Copyright property of CompuServe 
Incorporated. GIF (sm) is a Service Mark property of Compuserve Incorporated".

There are two specifications for GIF images in use. The older of the two is the "GIF87a" format. Most GIF 
images adhere to this format. A newer file specification, "GIF89a" provides for additional features such as 
text and graphic overlays which can be timed or keyed to user input. PixFolio supports these features.



Bitmap

A bitmap in the general sense is an array of pixel (picture elements) . A bitmap to Windows , being a 
Graphical environment, is the basic element of the windows display just like a character is in an non-
graphical environment. The windows display is made up of scores of bitmaps, large and small which 
make up different elements of the display. Bitmaps are used for such things as buttons, frames, title bars 
and also text. 

The term Bitmap can also be used more specifically to refer to an image stored on disk. Commonly, these
files have a .BMP extension. BMP files consist of a Windows bitmap along with some header information 
such as the size of the image, etc..



Cannot Open File xxxx...

If this file name was entered on the command line, you have probably made a mistake in 
entering the name. If this file was selected from the Open File dialog, this error could be 
caused by Window running out of file handles. In this case, check    your CONFIG.SYS file to 
insure that the entry FILES= is big enough. You may need to set it to 30    or greater 
depending upon how many applications you have running on your machine.



Unrecognized or invalid File Format

PixFolio cannot read the image. This could be caused by one of the following conditions:

The file extension is wrong. That is to say, it does not match the file's format. PixFolio 
assumes that the format, eg GIF has a file extension of ".GIF". 
The file has been corrupted.
The file format is not supported by PixFolio. Read the Tech Info to see if there are any 
messages detailing the format option giving the problem.
Windows has run out of memory.
Software bug in PixFolio.



Could not create BitmapFromDib

This message can occur when the DIB To Screen option is turned off and an error occurs 
creating the device dependent bitmap copy of the image. This can happen with very large 
images when you get low on memory. Program execution may continue but you may 
encounter other errors caused by low memory later, particularly when editing images or 
using the VIEW-LAYOUT SLIDES command.      



Must be different path/filename xxxx...

The path/filename that you specified for the target file is the same as the input file. Either 
rename the file when you copy it or copy it to another directory or disk.



Copy failed

When copying    or moving a file, a fatal error occurred. Most likely this is because there is 
insufficient space or a write error has occurred in the target directory. 



Duplicate File / File already exists at xxxx...

You are attempting to    catalog an image and the catalog already shows a file of the same 
name located in some other location on a hard drive. Only one hard drive location can be 
maintained for an image. You may choose to continue by pressing    OK or you may quit this 
operation by pressing Cancel.    If you choose to continue, the catalog will be changed to the 
new location.



Insert Disk / Insert Volume xxxxx in Drive x:

The Image that you are reading is located on a floppy disk whose    volume ID is xxxxx. 
Please insert the requested disk and press OK or press Cancel to abort the operation.



Incorrect Volume Label

This error occurs when trying to read a file from a floppy drive. The expected volume label is 
compared to the expected one. This error results if they differ. You may continue by pressing 
OK, retry by pressing Retry or cancel or abort the operation by pressing Cancel.



Rebuild Catalog Index / Are you ready to rebuild the index?

PixFolio is ready to rebuild the catalog index file. If you have not backed up the catalog, it 
may be prudent to do this first. To continue, press OK. To abort the rebuild, press Cancel.



Insufficient space to create xxxx.....

Prior to performing a    Move or Copy operation, PixFolio checks the output volume to see if 
there is enough space. This message results if there is not.

Your only operation is to press ok which will abort the operation. Then select another volume
or location to move/copy to.



Overwrite existing file?

If PixFolio finds a file of the same name at the target location for a save or move/copy 
operation, you will be prompted with this message. If ok to continue, press OK, else press 
cancel to abort the operation.



Confirm Delete

If you do not wish to continue, press Cancel. Otherwise press OK to delete the file.



Warning! / This may take a while...

Displaying a 24 bit image may take quite a while. This warning is here to notify you that his 
will happen and you should not prematurely assume that your machine has "locked up".

Options:

Yes - The screen will be painted "real time" so you can see it happen. This is the same as
if    the DIB to Screen option    was turned on.

No- The program will attempt to create a device dependent bitmap. Your machine will "hang" 
for quite a while.

Cancel- Quit processing this image completely.

In testing on a 20mhz 386, bitmaps in the size of 640 x 480 took as much as 20 minutes to 
display.

The reason for this is that Windows must lookup each 3 byte RGB color triplet in your image 
and attempt to match it to one of the 256 colors (16 colors if you do not have a 256 color 
video driver) that it has available to display. 

It is recommended that    once the image is displayed that    you save the image to some 
other 8 bit format such as GIF for later use. Also, you may wish to set the DIB to Screen 
option on. This will display the bitmap as it is being converted rather than after the entire 
bitmap has been processed.

Note: the same delay that you will experience here will apply whenever PixFolio has to 
manipulate the image such as during the various edit commands, stretching an image, or 
creating a the postage stamp image when cataloging an image or when part of the screen 
has to be repainted because another window invalidated part of it.

Note: This warning message can be inhibited by selecting the Display Warnings command.

Have patience!



xxx... has been modified / do you want to save it?

You have initiated some action that will erase the current image from the screen. but the 
image currently displayed has been changed. Do you want to save it before continuing?    
Press the "Yes" button to save the image,    "no" to not save the image or "cancel" to abort 
the requested operation. 



Empty Catalog / The selected catalog is empty...

The currently selected catalog is empty. This can happen if you have never cataloged any 
images; possibly you have just    created a new catalog or you are running PixFolio for the 
first time. Also, if the last Catalog Browse search command failed to find any images, this 
error could result.

To catalog an image, use File Open to read in an image, then select Catalog Catalog to 
catalog it; or - select the Catalog Build command to build a catalog.



New Catalog Created / Do you want to make xxx your current catalog?

The new    catalog has been created. Do you now wish to select this catalog as your active, 
current catalog? Enter "Yes" if ok, else, enter "NO"    to continue using the currently selected 
catalog.



Warning / xxx already exists, is it OK?

The filename that you have entered as the catalog file name already exists! Do not allow 
this name to be used unless you are sure that no other catalog name references it. 



Verify Uncatalog / Do you want to uncatalog xxx...?

This message is presented when you have selected a catalog entry to be uncataloged. Press 
"YES" to continue, othewise, "No".



Catalog xxx... not found

A catalog name entered on the command line when PixFolio was started is invalid. Check the
command line to insure that the correct catalog name is given. PixFolio will use the default 
catalog (CATALOG1=) in your WIN.INI file.



Error /    Unable to create the specified file format

This error occurs when attempting to create a new bitmap with a different number of bits 
per pixel in order to save the file in a different format from what it was read as.  The most 
likely cause is not enough memory to create the new bitmap.



Error / Unable to save the specified file

The save has failed. Two possible causes are insufficient disk storage space or a lack of 
memory.


